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Before You Start

This chapter contains the following information:

SUPPONt . 4
Legal Notes .. .. . . 4
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Before You Start
Support

Support

If you need technical support, please contact your MOBOTIX dealer. If your dealer cannot help you, he will
contact the support channel to get an answer for you as quickly as possible.

If you have internet access, you can open the MOBOTIX help desk to find additional information and software
updates. Please visit:

www.mobotix.com > Support > Help Desk

Legal Notes

Special Export Regulations!

Cameras with thermal image sensors ("thermal cameras") are subject to the special export regulations of the
U.S.A. and including the ITAR (International Traffic in Arms Regulation):

m According to the currently applicable export regulations of the U.S.A. and the ITAR, cameras with
thermal image sensors or parts thereof must not be exported to countries embargoed by the U.S.A,,
except if a special permit can be presented. At present, this applies to the following countries: Crimea
region of Ukraine, Cuba, Iran, North Korea, Sudan, and Syria. The same export ban applies to all per-
sons and institutions listed in "The Denied Persons List" (see www.bis.doc.gov, "Policy Guidance > Lists
of Parties of Concern"; https://www.treasury.gov/resource-center/sanctions/sdn-
list/pages/default.aspx).

m Under no circumstances must the camera itself or its thermal image sensors be used in the design, the
development or in the production of nuclear, biological or chemical weapons or in the weapons them-

selves.

Legal Aspects of Video and Sound Recording

You must comply with all data protection regulations for video and sound monitoring when using MOBOTIX
AG products. Depending on national laws and the installation location of the VAXTOR License Plate

Recognition - Dangerous Goods App, the recording of video and sound data may be subject to special
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Before You Start
Legal Notes

documentation or it may be prohibited. All users of MOBOTIX products are therefore required to familiarize
themselves with all applicable regulations and to comply with these laws. MOBOTIX AG is not liable for any

illegal use of its products.

Declaration of Conformity

The products of MOBOTIX AG are certified according to the applicable regulations of the EC and other coun-
tries. You can find the declarations of conformity for the products of MOBOTIX AG on www.mobotix.com

under Support > Download Center > Certificates & Declarations of Conformity.

RoHS Declaration

The products of MOBOTIX AG are in full compliance with European Unions Restrictions of the Use of Certain
Hazardous Substances in Electrical and Electronic Equipment (RoHS Directive 2011/65/EC) as far as they are
subject to these regulations (for the RoHS Declaration of MOBOTIX, please see www.mobotix.com, Support >

Download Center > Documentation > Brochures & Guides > Certificates).

Disposal

Electrical and electronic products contain many valuable materials. For this reason, we recommend that you
dispose of MOBOTIX products at the end of their service life in accordance with all legal requirements and reg-
ulations (or deposit these products at a municipal collection center). MOBOTIX products must not be dis-
posed of in household waste! If the product contains a battery, please dispose of the battery separately (the

corresponding product manuals contain specific directions if the product contains a battery).

Disclaimer

MOBOTIX AG does not assume any responsibility for damages, which are the result of improper use or failure
to comply to the manuals or the applicable rules and regulations. Our General Terms and Conditions apply.
You can download the current version of the General Terms and Conditions from our website at www.-

mobotix.com by clicking on the corresponding link at the bottom of every page.

FCC Disclaimer

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to
part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful inter-
ference when the equipment is operated in a commercial environment. This equipment generates, uses, and
can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual,
may cause harmful interference to radio communications. Operation of this equipment in a residential area is
likely to cause harmful interference in which case the user will be required to correct the interference at his

own expense.
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About Vaxtor Container Code Recognition App
Smart Data Interface to MxManagementCenter

About Vaxtor Container Code Recognition
App

Recognition of cargo container codes according to ISO 6346

Based on deep learning processes the certified Vaxtor Container Code Recognition App recognizes container
codes and delivers realtime results about the container owner, type dimensions and much more. The app is
able to detect container codes within 900 ms and an extremely high hit probability of over 99 percent. Via
blocking or permission lists, authorized, or containers with unauthorized content can be defined specifically.
Possible areas of use for the application are harbor & airport logistics, container inventory & surveillance, bor-

der control, access control or logistic management.

m Recognition of cargo container codes according to ISO 6346 standard

m with over 99% accuracy optimally suited for detection and logging of container codes on entry,
between zones, during processes or exit

m Two lists for individual actions (e.g. access granted/denied, alarm, etc.)

m Integrated Smart Data Interface for data retrieval with MxManagementCenter version 2.4.3 or higher.

CAUTION! Thermal sensors are not supported by this app.

Smart Data Interface to MxManagementCenter

This app has a Smart Data interface to MxManagementCenter.

With the MOBOTIX Smart Data System, transaction data can be linked to the video recordings made at the
time of the transactions. Smart Data source can be e.g. MOBOTIX P7 Apps (no license required) or general
Smart Data sources (license required) like POS systems or license plate recognition systems.

The Smart Data System in MxManagementCenter enables you to quickly find and review any suspicious activ-
ities. The Smart Data Bar and the Smart Data View are available for searching and analyzing transactions. The
Smart Data Bar provides a direct overview of the most recent transactions (from the last 24 hours) and for

this reason it is convenient to use it for reviews and searches.

NOTE! For information on how to use the Smart Data System, see the corresponding online help of the cam-
era software and MxManagementCenter.
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About Vaxtor Container Code Recognition App
Smart Data Interface to MxManagementCenter

Playback - Eisdiele

Eiscafé O v
Tisch #8 geschloss..
Bon #465
Bediener #2 / 30
2x Cola 0,5 8,00
Limonade 0,5 4,00
Tafelwasser ..3,00
4,00
19,00
Gesamtbetrag 19,00
Rechnung #392
Bediener #2 / 30
Tisch #39 geoeffnet
2x Zwiebels.. 11,00 €
2x Tomatens.. 11,00 €
Cola 0,5 4,00 €
Limonade 0,5 4,00 €
Tafelwasser ..3,00 €
Tisch #39 geschlos.

Rl 2 Heute 13:28:55 R

Recl:ung #393

Bediener #2

Tisch #8 geoeffnet

Bar 13,60 €

Gesamtbetrag 13,60 €
Do. ©05.10.17 13:28:54 Rechnung #3394

Bediener #2
Heute 14:01:! Eisdiele 6:40 min Biergarten

e @4 "

Fig. 1: : Smart Data Bar in MxManagementCenter (Example: POS System)
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Technical Specifications

Smart Data Interface to MxManagementCenter

Technical Specifications

Product Information

Product Name

Order Code

Supported MOBOTIX Cam-

eras

Vaxtor Container Code Recognition App

Mx-APP-VX-CON

Mx-MT3A, Mx-S74A

Minimum Camera Firmware v7.1.3.x

MxManagementCenter
Integration

min. MxMC v2.4.3

Configuration: Advanced Config license required

Event Search: Smart Data Interface license included

Product Features

App Features

Maximum number of recog- 1

nition areas

Maximum number of

enrolled license plates

Meta Data / Statistic

formats

1000 per list

JSON

Recognition of cargo container codes according to ISO 6346

Real time results:

Container Code

Owner and corresponding origin
Container Type

Container Dimensions

Control Digit

Control Digit Validation

Recognition log (Smart Data / Event Search via MxManagementCenter)

MOBOTIX events via MxMessageSystem

Two lists for individual actions (e.g. access granted/denied, alarm, etc.)

Free flow and Signaled mode
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Technical Specifications
Smart Data Interface to MxManagementCenter

Trial License

MxMessageSystem sup-
ported

Integration Interfaces

MOBOTIX Events

ONVIF Events

30-day trial license pre-installed

Yes

m MxMC Smart Data

m |P Notification

m Milestone X-Protect

m Vaxtor Helix

m generic 3rd party integration via XML

m compare supported camera's interfaces
Yes

Yes (Generic Message event)

Supported Container Codes

Supported Container Codes Container code specification according to ISO 6346

Scene Requirements

Character Height

Maximum Vertical Angle

20px - 50px

30°

Maximum Horizontal Angle <25°

Maximum Tilt Angle

<25°

Technical App Specifications

Synchronous / Asyn-
chronous App

Simultaneous execution of

other apps
Accuracy
Processed frame rate

Detection time

asynchronous

No

min. 99% (considering scene requirements)
typ. 10 fps

typ. 900 ms per Container
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Licensing Certified Apps
Activativating of Certified Apps in MxManagementCenter

Licensing Certified Apps

The following licenses are available for the Vaxtor Container Code Recognition App:

m 30-day test license pre-installed

m permanent commercial license

The usage period begins with activation of the app (see

NOTE!

For buying or renewing a license, contact your MOBOTIX Partner.

NOTE!

Apps are usually pre-installed with the firmware. In rare cases, apps must be downloaded from the website
and installed. In this case see www.mobotix.com > Support > Download Center > Marketing & Docu-
mentation, download and install the app.

Activativating of Certified Apps in
MxManagementCenter

After a test period commercial licenses must be activated for use with a valid license key.

Online-Activation

After receiving the activation IDs, activate them in MxMC as follows:

1. Select from the menu Window > Camera App Licenses.
2. Select the camera on which you want to license apps and click Select.
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Licensing Certified Apps
Activativating of Certified Apps in MxManagementCenter

LXK ] Camera Licenses

MxManagementCenter

Cameras

mx10-10-38-40 10.10.38.40 10.10.38.40
mx10-22-10-30 10.22.10.30 10.22.10.30

M73 10-32-0-62 .32.0. 10.32.0.62

Mobotix » Kalserstrasse D-67722 Langmell » Info@mobotix.com » www.mobotix.com

Fig. 2: Overview of Camera App Licenses in MxManagementCenter

NOTE!
If necessary, correct the time set on the camera.

1. Anoverview of the licenses installed on the camera may be displayed. Click Activate License.

L] L Camera Licenses

MxManagementCenter
< Camera License Status: mx10-251-1-235 Sertal Number: 10239371

MxWheelDetector Permanent Unlimited
iot_plugin_a Permanent Unlimited
iot_plugin_b Permanent Unlimited
iot_plugin_c Permanent Unlimited
iot_plugin_d Permanent Unlimited
iot_plugin_e Permanent Unlimited
iot_plugin_f Permanent Unlimited

Permanent Unlimited

Permanent Unlimited

Permanent Unlimited

/1) Camera time is incorrect. Please reset your camera time before activating Licenses

Activate License

Fig. 3: Overview of the licenses installed on the camera

NOTE!
If necessary, correct the time set on the camera.

2. Enter a valid Activation ID and specify the number of licenses to install on this computer.

3. If you want to license another product, click on | In the new row, enter the appropriate Activation ID

and the number of licenses you want.

4. Toremove a line click
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Licensing Certified Apps

Activativating of Certified Apps in MxManagementCenter

5. When you have entered all Activation IDs, click Activate License Online. During activation, MxMC con-
nects to the license server. This requires an Internet connection.

[ JeN ) Camera Licenses

MxManagementCenter

< Activate Camera Licenses: M73 10-32-0-62

Serial Number: 10.32.0.52
via Activation ID
Please enter your Activation |Ds and for each Activation ID the corresponding quantity of licenses that you want to use

we23-4c5{-as23-4bf2-b872-9c84-e935-78de [ 1 EEE

ec0-4c5f-cfd0-4bf2-bB72-9c84-6935-6120 M 1 |

Download Capability Request File Activate License Online

Via Capability Response File

If you have already created or received a capability response file (<DevicelD=.bin), you can load it here.

Load Capability Response File...

Mobaotix » Kaiserstrasse D-67722 Langmeil « iInfo@mobotix.com » www.mobotix.com
Fig. 4: Adding licenses
Successful activation

After successful activation, a new log in is required to apply the changes. Alternatively, you can return to
license management.

Failed activation (missing internet connection)

If the license server cannot be reached, e.g. due to a missing internet connection, apps can also be activated
offline. (see FigureNumberOnly).

Offline Activation

For offline activation, the partner/installer from whom you purchased the licenses can generate a capability
response (.bin file) on the license server to activate their licenses.

1. Select from the menu Window > Camera App Licenses.
2. Select the camera on which you want to license apps and click Select.
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Licensing Certified Apps
Activativating of Certified Apps in MxManagementCenter

LXK ] Camera Licenses

MxManagementCenter

Cameras

mx10-10-38-40 10.10.38.40 10.10.38.40
mx10-22-10-30 10.22.10.30 10.22.10.30

M73 10-32-0-62 .32.0. 10.32.0.62

Mobotix » Kalserstrasse D-67722 Langmell » Info@mobotix.com » www.mobotix.com

Fig. 5: Overview of Camera App Licenses in MxManagementCenter

NOTE!
If necessary, correct the time set on the camera.

3. An overview of the licenses installed on the camera may be displayed. Click Activate License.

L] L Camera Licenses

MxManagementCenter
< Camera License Status: mx10-251-1-235 Sertal Number: 10239371

MxWheelDetector Permanent Unlimited
iot_plugin_a Permanent Unlimited
iot_plugin_b Permanent Unlimited
iot_plugin_c Permanent Unlimited
iot_plugin_d Permanent Unlimited
iot_plugin_e Permanent Unlimited
iot_plugin_f Permanent Unlimited

Permanent Unlimited

Permanent Unlimited

Permanent Unlimited

/1) Camera time is incorrect. Please reset your camera time before activating Licenses

Activate License

Fig. 6: Overview of the licenses installed on the camera

NOTE!
If necessary, correct the time set on the camera.

4. Enter a valid Activation ID and specify the number of licenses to install on this computer.

5. If you want to license another product, click on . In the new row, enter the appropriate Activation ID

and the number of licenses you want.
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Licensing Certified Apps
Managing Licenses in MxManagementCenter

6. If necessary, click ‘to remove a line.

7. When you have entered all Activation IDs, click Download Capability Request File (.lic). and send it to

your partner/installer.

NOTE!
This file allows the partner / installer from whom you purchased the licenses to generate a capability
response file (.bin ) on the license server.

MxManagementCenter

< Activate Camera Licenses: M73 10-32-0-62 e (EREEE

via Activation ID

Please enter your Activation |Ds and for each Activation ID the corresponding quantity of licenses that you want to use

we23-4c5{-as23-4bf2-b872-9c84-e935-78de [ 1 EEE
ec0-4c5f-cfd0-4bf2-bB72-9c84-6935-6120 M 1 |

Download Capability Request File Activate License Online

Via Capability Response File

If you have already created or received a capability response file (<DevicelD=.bin), you can load it here.

Load Capability Response File...

Mobotix « Kalsersirasse D-67722 Langmeil + info@mobotix.com s www.mobotix.com

Fig. 7: Adding licenses
8. Click Load Capability Response File and follow the instructions.

Successful activation

After successful activation, a new log in is required to apply the changes. Alternatively, you can return to

license management.

Managing Licenses in MxManagementCenter

In MxManagementCenter you can comfortably manage all licenses that have been activated for a camera.

1. Select from the menu Window > Camera App Licenses.
2. Select the camera on which you want to license apps and click Select.
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Licensing Certified Apps

Managing Licenses in MxManagementCenter

Cameras

mx10-10-38-40
mx10-22-10-30

M73 10-32-0-62

Camera Licenses

MxManagementCenter

10.10.38.40 10.10.38.40
10.22.10.30 10.22.10.30

10.32.0.62

Mobotix » Kalserstrasse D-67722 Langmell » Info@mobotix.com » www.mobotix.com

Fig. 8: Overview of Camera App Licenses in MxManagementCenter

An overview of the licenses installed on the camera may be displayed.

Camera Licenses

MxManagementCenter

< Camera License Status: mx10-251-1-235 Saral uniec: 102301

MxWheelDetector
iot_plugin_a
iot_plugin_b
iot_plugin_c
iot_plugin_d
iot_plugin_e
fot_plugin_{
iot_plugin_g
iot_plugin_h

fot_plugin_i

Permanent Unlimited
Permanent Unlimited
Permanent Unlimited
Permanent Unlimited
Permanent Unlimited
Permanent Unlimited
Permanent Unlimited
Permanent Unlimited
Permanent Unlimited

Permanent Unlimited

) Camera time is incorrect. Please reset your camera time before activating Licenses

Activate License

Fig. 9: Overview of the licenses installed on the camera

NOTE!

If necessary, correct the time set on the camera.

Column
Name
Expiration

Quantity

Explanation
Name of the licensed app
the time limit of the license

Number of licenses purchased for a product.

Serial Num- Unique identification determined by MxMC for the device used. If problems occur during licens-

ber

ing, please have the device ID ready.
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Licensing Certified Apps
Managing Licenses in MxManagementCenter

Synchronize licenses with server

When the program starts, there is no automatic comparison of the licenses between the computer and the

license server. Therefore, click Update to reload the licenses from the server.
Update licenses

To update temporary licenses, click Activate Licenses. The dialog for updating/activating licenses opens.

NOTE!
You need administrator rights to synchronize and update licenses.

16/39



Camera, image and scene requirements
Managing Licenses in MxManagementCenter

Camera, image and scene requirements

The camera should be setup so that the combination of the distance, the lens’s focal length and the camera’s
resolution provide an image that can be accurately analyzed by the OCR. Therefore the following pre-

requisites must be fulfilled for the scene:

Quality of the container code to be captured in the image

m The container code must be high-contrast and clearly legible, i.e. as clean as possible, without dents or
holes and well illuminated.
m The code must comply with the standard ISO 6346
m  Minimum character height
m The objective of a container code recognition system is to capture an image with a good con-
tainer code. In order to achieve this all characters of container code should have a height

between 20 and 50 pixels.

OCR ACCURACY
Character Height (Pixels) 14 px 20 px 30 px 40 px 60 px The scale is not linear

Fig. 10: Minimum character height
= Maximum rotation angle:
m Vertical: <30°
m Slope: < 25°

m Horizontal: < 25°

Frame rate

The selection of the correct frame rate influences the recognition quality significantly. The recommendation is
10 fps.

Shutter Speed (Exposure time)

Shutter speed, also known as the “exposure time”, is the length of time a camera shutter is open for in order
to expose light onto the camera sensor. The shutter speed is measured in seconds, or fractions of a second.
The bigger the denominator, the faster the speed. For example, 1/250th means one two-hundred-and-fiftieth

of a second or four milliseconds.

(1 second = 1000 milliseconds)
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Camera, image and scene requirements
Managing Licenses in MxManagementCenter

Examples for recommended exposure times

Scene (Street type) minimum exposure time (sec)
Barrier or Gate 1/250t" (4 miliseconds)
NOTE!

The exposure time must be adjusted according to the light conditions.

Resolution

The resolution of the camera determines the amount of detail that can be captured. The smaller the object

detail, the higher the resolution that is required. There are several factors that determine the detail captured:

m The resolution (pixel size) of the camera sensor. This sensor (normally CMOS) where the light even-
tually falls and a typical IP camera has a sensor resolution of 2 or 4 Megapixels.

m The resolution of the camera’s electronics. Most CCTV cameras can support a minimum of 1920 x 1080
- but may be set to a lower resolution if not needed.

m The quality and focal length of the lens. The quality of the optics can play a part in challenging cir-
cumstances. The focal length (zoom factor) determines the field of view that can be seen.

m The quality of the images can be influenced by factors such as the type of lighting used.

Examples for recommend resolutions

Scene (Street type) minimum resolution
Barrier or Gate 800 x 600 px
Roadside Deployment 1280 x 720 px

Focal length

The focal length of the lens determines how “zoomed in” the image is. It is usually expressed in millimeters
(e.g., 6 mm, 25 mm, or 50 mm).

The focal length defines the angle of view (how much of the scene will be captured) and the magnification
(how large individual elements will be). The longer the focal length, the narrower the angle of view and the
higher the magnification. The shorter the focal length, the wider the angle of view and the lower the mag-

nification.
In the case of zoom lenses, both the minimum and maximum focal lengths are stated, for example 10-40 mm.

Examples for recommended focal length

Scene (Street type) Distance between camera and container code (m) recommended lens
Barrier or Gate 2-6m 2 - 8 mm or similar
Access road 15-30m 15 - 50 mm or similar
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Camera, image and scene requirements

Recommendations on mounting and adjusting.

NOTE!
The lens should be IR corrected to avoid out of focus images. IR Corrected lenses should be used on both

day/night and monochrome cameras in all lighting conditions in order to achieve a crisp sharp image.

Recommendations on mounting and adjusting.

m If you want to recognize container codes on multiple lanes it is generally recommended to mount the
camera on a crossbar.

m Shutter speed must be high enough to cut the light from car's headlights at night (usually it's about
1/1000). Keep in mind, that too high shutter speed may obscure the edges of the lines (especially shad-
ows).

m Depth of focus is a very important parameter. If you are using a camera with a CS-mount lens, use a
fixed lens. Fixed lens are better for container code recognition due to greater depth of focus. Megapixel
lens is also strongly recommended.

m Respect changing light conditions (e. g. due to sunrises and sunset) when choosing the place of mount-
ing. Direct sunlight beams can distort a picture. If the code is facing a direct sunlight consider using a
lens with auto iris mode.

m |f mounting a camera on a roadside pole check how the pole reacts to heavy cars or a convoy of cars.
Some poles have tangible tremor, this could make container code recognition almost impossible.

m Itis recommended to turn down WDR and BLC. In most cases, they will make the picture more pretty,
but at the cost of smudging details like an edges of letters in the container code. For the same reason
keep digital noise reduction as low as possible.

m On certain rare conditions there may be a cases of false detections e. g. because of recognizing image
parts that structurally or semantically look similar to a container code(e. g. fences or ads). To minimize
this:

m Adjust the region of interest accordingly. It may be a good idea to make it smaller, or change it’s
shape, omitting the parts, which potentially may be false detected.
m There may be cases, when the best performance will occur by changing angle of lens or moving the

camera. In some cases, shooting a front container code is better.
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Activation of the Certified App Interface
Recommendations on mounting and adjusting.

Activation of the Certified App Interface

CAUTION! Attention
The Vaxtor Container Code Recognition App does not consider obscure areas defined for the live image.

Therefore there is no pixelation in obscure areas while configuring the app and during image analysis by the

app.

NOTE! Note
The user must have access to the setup menu (http(s)://<Camera IP address>/control). Therefore check the

user rights of the camera.

Activation of Certified Apps and events

1. Inthe camera web interface, open: Setup Menu / Certified App Settings (http(s)://<Camera
IP address>/control/app_config).

”ﬂ 4 MOBOTIX S74 mx10-32-24-156 Certified App Settings 00
General Settings
Activate app service.
Arming @ Active Note: It is not recommended to activate
more than 2 apps.
App Settings
App Activation License Explanation Version Delete
- SMM°ﬁing§ Analytic [‘é%ﬂﬁgg_se MxAnalytics App 1.1 Data (4.0k)
. g;s:egeﬁ;rgglg'lsgilggies Trial Eaaillabl .  Please update the license. 1.2 Data
= Vaxtor LPR Trial E:ill able Please update the license. 1.1.2 Data
» Vaxtor ADR Trial I\zi:illable Please update the license. 11.2 Data
" 2021-03-25
= Vaxtor Containers @ @0d ;
. ay Vaxtor Containers 1.2.0
Satings trial).
-9 Factory Restore Close

Fig. 11: Activation of Certified Apps

Under General Settings activate the Arming @ of the app service.

Under App Settings check the Active option @ and click Set ® .

Click on the name of the App to be configured to open the Apps user interface.
For configuration of the App see FigureNumberOnly.

o s~ DN
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Configuration of Vaxtor Container Code Recognition App

Recommendations on mounting and adjusting.

Configuration of Vaxtor Container Code
Recognition App

NOTE!
For best performance and results in container code processing make sure to have scene set up to meet the
FigureNumberOnly.

CAUTION!
The user must have access to the setup menu (http(s)://<Camera IP address>/control). Therefore check the

user rights of the camera.

1. Inthe camera web interface, open: Setup Menu / Certified App Settings (http(s)://<Camera
IP address>/control/app_config).
2. Click on the name of the Vaxtor Container Code Recognition App.

The configuration window of the app appears with the following options:

VAXTOR Containers - Basic Settings

The following configurations should be taken into account:

f,'] 4 MOBOTIX S74 mx10-32-24-156 Vaxtor Containers Settings

Vaxtor Containers

Read container size and type

Read size and type information
Layout Both E:t?\d horizonal codes, vertical codes or
Same Code Delay 60 Minimum elapsed time to report the

same code twice (seconds)

Signaled: The application will only
attempt to read a container code when

Working Mode freeflow the signal is activated. Freeflow: The
application continuously captures
container codes.

Send a mxmessage when a container

Enable MxMessage code is read
Enable Overla Display an overlay on all the sensors
Y when a container code is read

Fig. 12: Basic settings

Read size and type: Check to read container size and type information
Layout: Select the which code layout types should be read. The options are.
Both
Horizontal codes
Vertical codes
Same code delay: Define the minimum elapsed time to report the same code twice (seconds).

21/39



Configuration of Vaxtor Container Code Recognition App
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Working mode: The following modes are available:
Free flow: The application continuously captures container code numbers.
Signaled: The application will only attempt to read a license plate number when the signal (trigger) is
activated.

Note
In signaled mode an signal ID will be sent with the signal event.

MxMessage: Check to enable the processing of LPR events in the MxMessageSystem.
Enable Overlay: Check to enable the display of the container code recognition result in the live view.

Recognition Areas

A Recognition Area, an area within the video frame where the OCR analytics takes place. You can draw a poly-
gon and choose whether the area to look for plates in Inside or Outside this region. You can set multiple areas
to respect complex situations.

NOTE!

Note

Using Recognition Area can decrease OCR processing time and also reduce false positives. The whole con-
tainer code must be in or out the Recognition Area to pass the test.

J ~ Recognition Areas l

Recognition Area Type. Inclusion: only
the plates inside the recognition area

Recognition Area Type inclusion B will be detected. Exclusion: only the
plates outside the recognition area will
be detected

Show the recognition area on the OCR

Show Recognition Area sensor

Position
S;':Z gjN373 & SHIFT + Click on the image to mark the
’ - i left-top corner then Click without SHIFT
SRRt AEn 410 ° x280 ° to mark the right-bottom corner. Press
"Set Rectangle" when done
Set Rectangle

Fig. 13: Recognition Areas

Recognition Area Type: Check to activate the sending of events according to the following configuration
Inclusion: only the plates inside the recognition area will be detected.
Exclusion: only the plates outside the recognition area will be detected.

Show Recognition Area: Check to display the recognition area in the camera image.

Drawing a Recognition Area

In the live view hold the Shift key and click the upper left corner point of the recognition area.
Release the Shift key and click on the lower right corner point of the recognition area.
In the configuration interface click Set Rectangle to adopt the coordinates of the rectangle.

Ll N

Optionally click the bin icon to delete the recognition area.
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Recommendations on mounting and adjusting.

List Management

You can define a black list and a white list with up to 1000 container codes per list. If a container code from
one of the lists is recognized, a corresponding event is sent within the MxMessageSystem of the camera.

J ~ List Management l

Filter: @

CBCU2000317 x

CSQU3054383 x
Container codes on the whitelist. Only
Whitelist HJCU8281 95@@ the container code. Valid separators are

commas, new line, spaces, tab or
MZLU0604055 x @

semicolon.
ololo

4] o]

Fig. 14: Black and white lists

Container codes on the blacklist. Only
the container code. Valid separators are
commas, new line, spaces, tab or
semicolon.

Blacklist

Adding a container code to a list

1. Enter the container code text into the text field ® and click Enter.

Adding multiple license plates from a text file

1. Make sure that your text file contains one license plate per line.

2. Copy the relevant license plates from the text file and paste them into the text field @ .

Deleting a container code from a list

1. Click on the small x @ to the right of the license plate number.

Deleting all container codes from a list

1. Click the trash icon ® .

Sorting all container codes from a list alphabetically

1. Click the sorticon @ .

Copy all container codes from a list to the clip board

1. Click the copy to clipboard icon ® .
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Filtering container codes

1. Enter the license plate or parts of it into the filter text field ® . Only license plates containing the filter
text are displayed accordingly

Video
In the video tab you can specify video quality of the video to be analyzed.
J ~ Video |
OCR Sensor Right sensor Sensor used to recognize containers
Sensor used to capture overview
Overview Sensor None images when a container code is

detected

Working resolution. Adjust the
resolution and the camera zoom to

Resolution 1920x1080 capture the containers codes on the
optimum range. Changing this option
will require a camera reboot

Minimum character height in pixels

Minimum Character Height 18 ¢ (14-70). Tip: optimal reading size is 25
pixels height
Maximum character height in pixels
Maximum Character Height 42  : (14-70). Tip: optimal reading size is 25

pixels height

Fig. 15: Video

OCR sensor: Select the camera sensor to be used for container code recognition.

Note
Changing this option requires a camera reboot.

Overview Sensor: Optionally select a sensor used to capture overview images when a plate is detected.
Resolution: Set the working resolution (current maximum is 1080p). Adjust the resolution and the camera
zoom to capture the codes on the optimum range.

Note
Changing this option requires a camera reboot.

Minimum Character Height: the minimum height that a container code’s characters should be before being
read. The characters should be about 20-30 pixels high.
Maximum Character Height: the maximum height is about 20-30 pixels.

Note
The recommended difference between the min and max heights is about 10 pixels.

OCR

In the OCR (Optical Character Recognition) tab you can set parameters to ensure the best possible recog-
nition results.
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-~ OCR | |

Tip: Set low if you're losing containers
" . ’ codes because lack of performance,
Analytics Complexity Medium Medium: default.fnorma'l:soenario

conditions, High: low quality video

Fig. 16: OCR

Analytics Complexity: This is the complexity of the analytics to be applied during the OCR engine’s stage of
plate reading. Set this according to the OCR mode and type of traffic expected. There are three options.
Low: Recommended for very high-speed traffic where the OCR needs to work faster and your preference
is for plate detection over perfect recognition.
Medium (Default) Recommended when the OCR mode is set to free-flow.
High: Recommended when the OCR mode is set to signal (triggered).

CAUTION!
Higher complexities give more accurate reading but make the ALPR engine run slower.

Reporting

Vaxtor Container Code Recognition App is able to output all plate reads in real time using a variety of stand-
ard protocols so that the plate reads can be accepted remotely by a variety of programs including Vaxtor’s
powerful Back Office - Helix, which can accept and store plate reads in real time from hundreds cameras.

By selecting one of the listed protocols, a sub-menu will appear with fields for setting up parameters such as
remote IP addresses etc.
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Recommendations on mounting and adjusting.

J ~ Reporting

Retry Notifications

Retry Period
Send Test

Text Overlay

Overlay Template

Fade out timer

Show container code image
Image position (x)

Image position (y)
MxMessage

MxMessage Template

Subpath

Vaxtor Helix-6
Enable

JSON

Enable

XML

Enable

Enable
TCP Server

Enable

Fig. 17: Reporting

Retry notifications: Check to retry failed notifications (Helix-6 and JSON only).

$date$ - $containercode$

50

de": "$confidencecode$"}

Milestone Analytic Event

Retry failed notifications (Helix-6 and
JSON only)

Amount of seconds between notification
retries

Send a fake read (TEST) when settings

are stored or when the camera is
started

Template to use on the overlay, check
the manual for available keywords

Amount of seconds that the overlay will
be visible or 0 to make it perpetual

Display a small image with the
container code detected

Coordinate position for the image (x)

Coordinate position for the image (y)

Defines the template of customized part
of the MxMessage. Check the manual
for available keywords

Send all results to the configured
Helix-6 server

Enable JSON HTTP/HTTPS POST
reporting

Enable XML HTTP/HTTPS POST
reporting

Enable analytic event reporting

Enable TCP server reporting

Retry period: Amount of seconds between notification retries

Send test: Check to send a fake read (TEST) when settings are stored or when the camera is started.

Text Overlay

Overlay Template: Define template to use on the overlay. Check the Template Fields for available

keywords.

Fade out timer: Set the amount of seconds that the overlay will be visible or 0 to make it perpetual.
Show container code image: Check to display a small image with the container code detected.

Image position (x): x coordinate position for the image.

Image position (y): y coordinate position for the image.

MxMessage

MxMessage Template: Define template of customized part of the MxMessage . Check the Template

Fields for available keywords.

Subpath: Define a subpath for the MxMessage. Check the Template Fields for available keywords.
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Configuration of Vaxtor Container Code Recognition App
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Vaxtor Helix-6 : Helix-6 protocol is an encrypted version of the Vaxtor protocol.
Enable : Check to send all results to the configured Helix-6 server.
JSON : JSON is a compact data format in an easy-to-read text form for data exchange between applications.
Enable : Check to enable JSON HTTP/HTTPS POST reporting.
XML : XML is a compact data format in an easy-to-read text form for data exchange between applications.
Enable : Enable XML HTTP/HTTPS POST reporting
Milestone Analytic Event : With the Analytics Events feature it is possible to send MAD (Milestone Alert Data)
formatted alerts to the Milestone XProtect event server over TCP/IP.
Enable : Enable analytic event reporting
TCP Server:
Enable : Enable TCP server reporting

Advanced
In this section you find useful tools for calibration and trouble shooting.
J ~ Advanced |
Info: Default log level. Debug: Enable
debug log level, useful to diagnostic
. A messages recieved from third parties.
Log level info Trace: Enable trace log level, useful to
diagnotic messages send to third
parties.
) If enabled, the on-screen log file will be
Show Log File On Screen displayed on the selected sensor
Sensor Right sensor dSiggls:; e\zhere the on-screen log file is
Show Calibration Grid e ok Clegiay on the OGR senecr a

Fig. 18: Advanced

Log level: Select a debug level to generate a log file, which can be helpful e.g. for trouble shooting.
Info: Default loge level
Trace: Select e. g. for diagnostic messages received from third parties
Debug: Select for complete log files for debug purposes

Show log file on screen: Check to display the on-screen log file on the selected sensor

Sensor: Select the sensor on which the on-screen log file is displayed

Show Calibration Grid: Check to display on the OCR sensor a 20 pixels height grid

Storing the Configuration

To store the configuration you have the following options:

| B ooy Restore Close

Fig. 19: Storing the configuration

m Click on the Set button to activate your settings and to save them until the next reboot of the camera.
m Click on the Factory button to load the factory defaults for this dialog (this button may not be present

in all dialogs).
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m Click on the Restore button to undo your most recent changes that have not been stored in the cam-
era permanently.

m Click on the Close button to close the dialog. While closing the dialog, the system checks the entire con-
figuration for changes. If changes are detected, you will be asked if you would like to store the entire
configuration permanently.

After successfully saving the configuration, the event and meta data are automatically sent to the camera in

case of an event.
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About MxMessageSystem

What is MxMessageSystem?

MxMessageSystem is a communication system based on name oriented messages. This means that a message
must have a unique name with a maximum length of 32 bytes.

Each participant can send and receive messages. MOBOTIX cameras can also forward messages within the
local network. This way, MxMessages can be distributed over the entire local network (see Message Area:
Global).

For example, a MOBOTIX 7 series camera can exchange an MxMessage generated by a camera app with an
Mx6 camera that does not support certified MOBOTIX apps.

Facts about MxMessages

m 128-bit encryption ensures privacy and security of message content.
m MxMessages can be distributed from any camera of the Mx6 and 7 series.

m The message range can be defined individually for each MxMessage.
m Local: Camera expects an MxMessage within its own camera system (e.g. through a Certified

App).
m Global: the camera expects an MxMessage that is distributed in the local network by another
MxMessage device (e.g. another camera of the 7 series equipped with a certified MOBOTIX app).
m Actions that the recipients are to perform are configured individually for each participant of the
MxMessageSystem.
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Basic configuration: Processing the
automatically generated app events

Checking automatically generated app events

NOTE!
After successfully activating the app (see FigureNumberOnly), a generic message event for this specific app
is automatically generated in the camera.

1. Go to Setup-Menu / Event Control / Event Overview. In section Message Events the automatically gen-
erated message event profile is named after the application (e. g. VaxOCRContainer).

fi &« MOBOTIX S74 mx10-32-24-156 Event Overview o0
Environment Pl The selected sensor is currently not Edit
Events available! Inactive  Delete
Image Analysis . .
Events AS MxActivitySensor Inactve  Delste Edit...

VM Video Motion .
Inactive  Delete

VM2 Video Motion .
Inactive  Delete

Internal Events No profiles defined. Edit...
Message Events VaxOCRContainer MxMessageSystem actve  Dalete @

MxAnalytics MxMessageSystem o
Mx My t
FFLPRAM xMessageSystem Inactive  Delete
Meta Events No profiles defined. Edit...
ignal Input Edit...
Signal Events sl Signal Inpu Micive. Dalats i
UC Soft Button
el Inactive  Delete
Time Events PE Periodic Event s O Edit...
Set Restore Close

Fig. 20: Example: Generic message event from Vaxtor Container Code Recognition App
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2. Click Edit® to display a selection of all configured message events.

fi @ MOBOTIX S74 mx10-32-24-156 Message Events 00
Attribute Value Explanation
IP Recelve 8000 © ‘?gg:pon 1o listen on.
Events Value Explanation
Jv VaxOCRContainer l J Inactive Delete L
5 ~ Event Dead Time:
& Time to wait [0..3600 s] before the event can trigger
anew.
. Sen: :
Event Sensor Type IP Receive Chooes the mossage sensor

© MxMessageSystem

Event on receiving a message from the MxMessageSystem.

; Message Name:
VaxOCRContainer Defines an MxMessageSystem name to wait for.
- Message Range:
Local There are two different ranges of message

distribution:
Global: across all cameras within the current LAN.
Local camera internal.

Filter Message Content:

Optionally choose how to ignore messages
containing Filter Value. Select No Filter to trigger on
any message with defined Message Name.

©

No Filter

Fig. 21: Example: Generic message event details - no filter

Action handling - Configuration of an action group

CAUTION!

To use events, trigger action groups or record images the general arming of the camera must be enabled

(http(s)/<Camera IP address>/control/settings)

An action group defines which action(s) is (are) triggered by the Vaxtor Container Code Recognition App

event.

1. Inthe camera web interface, open: Setup Menu [ Action Group Overview (http(s)://<Camera

IP address>/control/actions).

£y €« MOBOTIX S74 mx10-32-24-156 Action Group Overview 00
Name Arming Events & Actions Edit
VisualAlarm Off E (select all) Edit.

Delete (No time table) VA
Vax_Container_Action Enabled MSG Edit @

Delete (No time table) SD

Add new group @
Set Restore Close

Fig. 22: Defining Action Groups

2. Click Add new group® and give a meaningful name.

3. Click Edit®@ , to configure the group.
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2-24-156 Action

up Details

Action Group

Event Selection

Action Details

Actions

Set

General Settings

Value

Vax_Container_Action

Enabled @

(No time table)

(Image Analysis: VM2)

Message: VaxOCRContainer

Message: MxAnalytics
Message: FFLPRAM @

(Signal: SI)

5

Simultaneously

Value

Factory

@

Add new action @

Restore

Close

Explanation

Name:
The name is purely informational.

Arming:

Controls this action group:

Enabled: activate the group.

Off- deactivate the group.

St group armed by signal input.

CS: group armed by custom signal as defined in
General Event Settings.

Time Table:
Time table for this action profile (Time Tables).

Event Selection:

Select the events which will trigger the actions below.
Use [Ctri}-Click to select more than one event.
Evenls in parentheses need to be activated first.

Action Deadtime:
Time to wait [0..3600 s] before a new action can take
place.

Action Chaining:
Choose how the status of each subaction influences
the execution of all others.

Simuitaneously. All actions are executed
simultaneously.

Simuitaneously until first success: Simultaneous
execution, but as soon as one action succeeds (i.e.
has been completed or the phone is picked up), all
others are terminated.

Consecutively: All actions are executed in the
specified order.

Consecutively until first success: Consecutive
execution, but as soon as one action succeeds, the
following actions are not executed.

Consecutively until first failure: Consecutive
execution, but as soon as one action fails, the
following actions are not executed.

Explanation

Fig. 23: Configuring an Action Group

Enable Arming® of the Action Group.

Select your message event in the Event selection list @ . To select multiple events, hold the shift key.

1.
2.
3. Click Add new Action® .
4, Select a proper action from list Action Type and Profile® .

Action Details

Actions
Action 1

Delete

Set @

FTP: FTP-Day-Period

E-Mail: AlarmMail

E-Mail: NotifyMail

E-Mail: MailWithMxPEGClip
E-Mail: MailWithStorylmages
E-Mail: MailSystemStatus24
IP Notify: MxMC-Alarm

IP Notify: MxMC-Liveview

IP Notify: MxMC-Gridview

IP Notify: TCPMessage

IP Notify: HttpRequest

IP Notify: ObscureAreaOn

IP Notify: ObscureAreaOff
Play Sound: StandardSounds

Visual Alarm: Red Frame
Image Profile: Ultra HD
Image Profile: QXGA

|_FTP: FTP-Webcam

0

Factory

Restore

~
Sk

Close

Action Deadtime:
Time to wait [0..3600 s] before a new action can take
place.

Action Chaining:

Choose how the status of each subaction influences
the execution of all others.

Simuitaneously. All actions are executed
simultaneously.

Simuitaneously until first success: Simultaneous
execution, but as soon as one action succeeds (i.e.
has been completed or the phone is picked up), all
others are terminated.

Consecutively: All actions are executed in the
specified order.

Consecutively until first success: Consecutive
execution, but as soon as one action succeeds, the
following actions are not executed.

Consecutively until first failure: Consecutive
execution, but as soon as one action faiis, the
following actions are not executed.

Explanation

Action Type and Profile:
Select the Action Profile to be executed.

Action Timeout or Duration:

If this action runs longer than the time specified
[0..3600 s}, it is aborted and returns an error; 0 to
daactivata

Fig. 24: Select Action Type- and Profile
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NOTE!
If the required action profile is not yet available, you can create a new profile in the Admin Menu sections
"MxMessageSystem", "Transfer Profiles" and "Audio and VolP Telephony".

If necessary, you can add further actions by clicking the button again. In this case, please make sure that

the "action chaining" is configured correctly (e.g. at the same time).

5. Click on the Set button at the end of the dialog box to confirm the settings.

Action settings - Configuration of the camera recordings

1. Inthe camera web interface, open: Setup Menu / Event Control / Recording(http(s)/<Camera
IP address>/control/recording).

fi @ MOBOTIX S74 mx10-32-24-156 Recording 00
General Settings Value Explanation
Arming eaved B(1) ATBCCOTING. 1

Enabled: activate recording.

Off: deactivate recording.

Si: recording armed by signal input.

CS: recording armed by custom signal as defined in
General Event Settings.

From Master. copies recording arming state from
master camera.

: A Time Table Profile:
(No time table) Time table profile for time-controlled recording (Time

Tables).

Storage Settings Value Explanation
Recording (REC) Event Recording @ ;!;::gm m:‘:ﬁ:mw —

Snap Shot Recording: stores single JPEG pictures.
Event Recording: stores stream files for every event
using MxPEG codec.

Conlinuous Recording: continuously streams video
data to stream files using MxPEG codec. Events can
be recorded with a higher frame rate using Start
Recording, Retrigger Recording and Stop Recording.

Start Recording:
Select the events which will start recording.

Use [Ctrl]-Click to select more than one event.
Events in parentheses need to be activated first.

Start Recording

(Image Analysis: VM2) o

Message: VaxOCRContainer

Message: MxAnalytics
Message: FFLPRAM
(Signal: SI)

~ Event Frame Rate:
Max fps Recording speed if an event is detected, in frames

per second.

Recording Time Before Event:
Additional recording time before an event in
seconds.

10s Recording Time:

Time to include in recorded stream after an event
has occurred.

Set @ Factory Restore Close @ More

Fig. 25: Configuration of camera recording settings

2. Activate Arm Recording @ .
3. Under Storage Settings / Recording (REC) select a Recording mode @ . The following modes are avail-
able:

m Snap Shot Recording
m Event Recording

m Continuous Recording

4. In list Start recording ® select the message event just created.
5. Click on the Set @ button at the end of the dialog box to confirm the settings.
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6. Click on Close ® to save your settings permanently.

NOTE!

Alternatively, you can save your settings in the Admin menu under Configuration / Save current con-
figuration to permanent memory.
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Meta data transferred within the MxMessageSystem

Advanced Configuration: Processing the
meta data transmitted by apps

Meta data transferred within the
MxMessageSystem

For each event, the app also transfers meta data to the camera. This data is sent in the form of a JSON

schema within an MxMessage.

[ X N ] 192.168:178.100/api/json/message ™ 2 -

SR R A 2 192.168.178.100/apifjson/message v @ . 0\

-

gin @) Intranet News [ Wetter HD | Wette

JSON Rohdaten Kopfzeilen

{
"local" :
{
"VaxOCRContainer" :
{
"container" :
{
"Confidence" : "g92",
"ContainerCode" : "ALLU916879745G1",
"ControlDigit" ; "7",
"List" : "White List",
"Owner" : "ALMAR CONTAINER INVESTMENTS INC.",
"OwnerBase" : "Durban, South Africa",
"OwnerCode" : “ALLU",
"Size" : "40 feet X 8 feet 6 inches - High Cube -",
"Time" : "2021-02-15T10:38:49.191+01:00",
"Type" : "HIGH CUBE CONTAINER",
EE

s
"custom" :

"ConfidenceCode" : "2"

}

Fig. 26: Example: Meta data transmitted within an MxMessage of the Vaxtor Container Code Recognition App

NOTE!
To view the meta data structure of the last App event, enter the following URL in the address bar of your
browser: http(s)/IPAddresseOfYourCamera/api/json/messages
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Creating a Custom Message Event

1. Go to Setup-Menu / Event Control / Event Overview. In section Message Events the automatically gen-

erated message event profile is named after the application (e. g. VaxOCRContainer).

fi &« MOBOTIX S74 mx10-32-24-156 Event Overview o0
Environment Pl The selected sensor is currently not Edit
Events available! Inactive  Delete
Image Analysis . -
Events S MxActivitySensor Inactive  Delete ——
: ;
i oMot Inactive  Delete
- ’
VME Video Motion Inactive  Delete
Internal Events No profiles defined. Edit...
Message Events VaxOCRContainer MxMessageSystem actve  Dalete :i)
MxAnalytics MxMessageSystem o
Mx My t
FFLPRAM xMessageSystem Inactive  Delete
Meta Events No profiles defined. Edit...
ignal Input Edit...
Signal Events S| Signal Inpu oo Dl i
el LD Inactive  Delete
Time Events PE Periodic Event : Edit...
nmatiin  Palata
Set Restore Close

Fig. 27: Example: Generic message event from Vaxtor Container Code Recognition App
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Creating a Custom Message Event

2. Click Edit® to display a selection of all configured message events.

Attribute Value
IP Receive 8000
Events Value

Jv VaxOCRContainer

fi € MOBOTIX S74 mx10-32-24-156 Message Events

OL

5 4

00
Explanation
Port:
TCP port to listen on.
Explanation
J Inactive Delete L
Event Dead Time:

Time to wait [0..3600 s] before the event can trigger
anew.

Fig. 28: Example: Blacklist message event

Factory

Set @

Restore

Close

Event Sensor e < Event Sensor Type:
Typ IP Receive Choose the message sensor.
© MxMessageSystem
Event on receiving a message from the MxMessageSystem.
. . Message Name:
VaxOCRContalner.cuntamer.L@ Defines an MxMessageSystem name to wait for.
~ Message Range:

Local There are two different ranges of message
distribution:

Global: across all cameras within the current LAN.
Local: camera internal.
. ~ Filter Message Content:

JSON Comparison Optionally choose how to ignore messages
containing Filter Value. Select No Filter to trigger on
any message with defined Message Name.

W ist" Filter Value:

Black List Define either a valid reference value as a string (in
JSON format) without line breaks, or an extended
regular expression. Open help for examples.

This parameter allows using variables.
Y
J P MxAnalytics l J Inactive Delete
J w FFLPRAM l J Inactive Delete l
Event Dead Time:

Time to wait [0..3600 s] before the event can trigger
anew.

3. Click on the event (e. g. VaxOCRContainer) @ to open the event settings.
Configure the parameters of the event profile as follows:

Message Name: Enter the "Message Name" @ according to the event documentation of the cor-

m Local: Default settings for the Vaxtor Container Code Recognition App
m Global: (MxMessage is forwarded from another MOBOTIX camera in the local network.

|
responding app (seeFigureNumberOnly)
m Message Range:
m Filter Message Content:
m Generic Event: “No Filter”
m Filtered Event: “JSON Equal Compare”
Filter Value: ® seeFigureNumberOnly.
CAUTION!

“Filter Value“ is used to differentiate the MxMessages of an app / bundle. Use this entry to benefit from indi-

vidual event types of the apps (if available).

Choose “No Filter” if you want to use all incoming MxMessages as generic event of the related app.

2. Click on Set @ at the end of the dialog box to confirm the settings.
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Examples for message names and filter values of the Vaxtor Container Code Recognition App

Examples for message names and filter values of
the Vaxtor Container Code Recognition App

MxMessage-Name Filter value
Generic Event VaxOCRContainer
Whitelist Event VaxOCRContainer.container.List “White list”
Blacklist Event VaxOCRContainer.container.List “Black list”
Not listed Event VaxOCRContainer.container.List “Not listed”
Unique container code  VaxOCRContainer.container.ContainerCode Container code as
event “STRING”; e.g.

“ALLU910879745G1

(compare Fig-
ureNumberOnly)

Owner Code Event VaxOCRContainer.container.OwnerCode e.g. “ALLU”
Container Type Event VaxOCRContainer.container.Type e.g. “HIGH CUBE
CONTAINER”
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